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AVVERTENZE DI SICUREZZA E LINEE GUIDA

Si prega di leggere completamente questo manuale prima di usare questo dispositivo,

prestando particolare attenzione a queste avvertenze di sicurezza e linee guida. Tenere

questo manuale in un luogo sicuro in caso di riferimento futuro.

Fare attenzione a non danneggiare il nastro blu sul piano di costruzione.

Fare attenzione a non toccare le parti calde, inclusi i blocchi termici, 'ugello
dell’estrusore e il filamento estruso.

Non indossare guanti operando o riparando per evitare di rimanere impigliati.
Tenere la stampante e tutti i suoi accessori fuori dalla portata dei bambini.
Non rimuovore o scollegare il cavo USB quando si sta stampando da un computer.

Non forzare o strappare nulla durante il disimballaggio e I'impostazione. Potrebbe
causuare dei danni alla stampante e/o ai suoi accessori.

Non inserire le mani all'interno della stampante durante 'uso.

Lasciare sempre il tempo alla stampante e al filamento estruso di raffreddarsi prima
di inserire le mani.

Assicurarsi che la stampante sia spenta e scollegata dalla sua fonte di alimentazione
prima di effettuare riparazioni o eseguire qualche operazione.

Non installare questo dispositivo su una superficie instabile dove potrebbe cadere e
causare lesioni personali o danneggiare il dispositivo e/o altre apparecchiature.

Non sottoporre il prodotto a forza estrema, shock o fluttuazioni di temperature o
umidita.
Questo dispositivo & concepito esclusivamente per I'uso interno.

Non esporre questo dispositivo ad acqua o umidita di qualunque tipo. Non
posizionare bevande o altri recipienti contenenti liquidi al di sopra o nelle vicinanze
del dispositivo. Nel caso un liquido finisse sopra o all'interno del dispositivo,
scollegarla immediatamente dall’alimentazione e lasciarla asciugare completamente
prima di ricollegarla.



e Non toccare con mani bagnate il dispositivo, il cavo di alimentazione o qualunque
altro cavo collegato.

e Usare solo in ambienti ben ventilati. Non usare in spazi chiusi e confinati.

e Prima dell'uso, controllare che 'unita e il cavo di alimentazione non siano
danneggiati. Non utilizzare nel caso siano danneggiati.

e Prima di collegare 'unita a una presa di corrente, assicurarsi che la presa fornisca lo
stesso tipo e lo stesso livello di corrente richiesta dal dispositivo.

e Scollegare il dispositivo dalla fonte di alimentazione quando non in uso.

e Assicurarsi di prevenire qualsiasi danno al cavo di alimentazione. Non permettere
che non diventi arricciato o schiacciato, che qualcuno ci cammini sopra o che si
aggrovigli ad altri cavi. Assicurarsi che il cavo di alimentazione non presenti un
pericolo di inciampo.

e Non scollegare mai l'unita tirando il cavo di alimentazione. Assicurarsi sempre di

impugnare la testa del connettore oppure il corpo dell’adattatore.

SERVIZIO CLIENTI

[l dipertimento del Servizio Clienti Monoprice e dedicato ad assicurare che la sua
esperienza di ordinazione, acquisto e consegna sia seconda a nessuno. Se dovesse avere
problemi con il suo ordine, ci dia I'opportunita di porvi rimedio. Pud contattare un
rappresentate del Sevizio Clienti Monoprice attraverso il link Live Chat sul nostro sito web
www.monoprice.com durante il normale orario lavorativo (Lun-Ven: 5am-7pm PT, Sab-

Dom: 9am-6pm PT) oppure via email all'indirizzo support@monoprice.com



CONTENUTO DELLA CONFEZIONE

La preghiamo di fare l'inventario del contenuto della confezione per assicurarsi di essere in

possesso di tutti gli oggetti elencati qui sotto. Se qualcosa dovesse mancare o essere

danneggiato, contatti il Servizio Clienti Monoprice per la sostituzione.
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1x Chiave inglese

1x Confezione di

1x Set di brugole

1x Colla solida

grasso
1x Tubo guida 1x Tubo in PTFE
PANORAMICA DEL PRODOTTO

Vista Frontale

1.

Touch screen

Tasto Touch screen
Ugello

Asta guida asse Z
Piano di costruzione

Manopola di livellamento




Vista dall’Alto

10.

.

Cartuccia del filamento
Estrusore

Immissione del filamento
Asta guida asse X

Pressatore a molla

Vista dal Lato Destro

12.

13.

Ingresso chiavetta USB

Ingresso cavo USB

Vista Posteriore

14. Ingresso alimentazione




SISTEMA MENU OSD

Menu Principale
[l Menu Principale viene visualizzato dopo l'accensione e l'inizializzazione della stampante.

e Toccare il tasto Costruzione per
accedere al Menu Costruzione.

e Toccare il tasto Preriscaldamento per :
accedere al Menu Preriscaldamento. ; ')/\

e Toccare il tasto Strumenti per accedere Build Preheat Tools
al Menu Strumenti.

Menu Costruzione

I Menl Costruzione viene visualizzato toccando il tasto Costruzione nel Menu Principale.

e Toccare il tasto Memoria Interna per

leggere il file di stampa dalla memoria e e o
interna. 3.00GB, 4.00GB

e Toccare il tasto Chiavetta USB per USB Stick

1.25GB, 7.80GB

leggere il file di stampa dalla chiavetta
USB.

e Toccare il tasto Indietro per tornare al

menu precedente.
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Menu Stampa

Il Menu Stampa viene visualizzato dopo aver selezionato un file di stampa dalla memoria
interna oppure dalla chiavetta USB. Il nome del file di stampa viene mostrato insieme a una
stima del tempo necessario a completare il processo di stampa.

e Toccare il tasto Costruzione per iniziare  flliz

’ 20mm_box.gx

a stampare il file di stampa caricato.

e Toccare il tasto Copia per copiare il file
. . Total: Ohrs 18mins
di stampa caricato.

e Toccare il tasto Cancella per cancellare il g o~
file di stampa caricato. [a] ﬁ
Build Copy Delete

e Toccare il tasto Indietro per tornare al
menu precedente.

Schermata Avanzamento di Stampa

La Schermata di Avanzamento di Stampa viene visualizzata durante il processo di stampa.
Mostra il nome del file di stampa, la temperatura attuale e quella da raggiungere,

I'avanzamento del processo di stampa con il relativo tempo rimanente.

e Toccare il tasto Annulla per annullare la

stampa.
P 20mm_box.gx

e Toccare il tasto Pausa per mettere in | Extruder 220°C/220°C
pausa la stampa. Premere il tasto

Time left: Ohrs 13mins

Riprendi per riprendere la stampa.

e Toccare il tasto Altro per accedere al ' '
Menu Altro Abort Pause
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Menu Altro

[l Menu Altro viene visualizzato toccando il tasto Altro nella Schermata Avanzamento di
Stampa.

e Toccare il tasto Filamento per cambiare
il filamento durante la stampa. Si prega
di notare che prima di poterlo fare, il

processo di stampa deve essere messo - =
ilament
in pausa. Shutdown
e Toccare il tasto Termina-Arresta per Cancsl

iniziare il processo di arresto

automatico una volta che la stampa e
terminata.

e Toccare il tasto Annulla per tornare alla Schermata Avanzamento di Stampa.

Menu Preriscaldamento

Il Menu Preriscaldamento viene visualizzato toccando il tasto Preriscaldamento nel Menu
Principale.

e Toccare il tasto Estrusore per impostare
la temperatura di stampa da
raggiungere. La temperatura standard & [IRESER .
di 220°C.

e Toccare il tasto Inizio per iniziare a
preriscaldare l'estrusore.

e Toccare il tasto Indietro per tornare al menu precedente.

12



Schermata Temperatura Preriscaldamento

La Schermata Temperatura Preriscaldamento viene visualizzata toccando il tasto Estrusore

nel Menu Preriscaldamento.

Toccare una singola cifra per selezionare
la cifra da cambiare.

Temperature adjust(C)

Toccare il tasto - per diminuire il valore

della cifra evidenziata. — 2 0 +

Toccare il tasto + per aumentare il
valore della cifra evidenziata.

Toccare il tasto Si per salvare il valore di
temperatura visualizzato e tornare alla schermata precedente.

Toccare il tasto No per annullare i cambiamenti e tornare alla schermata precedente.

Schermata Preriscaldamento

La Schermata Preriscaldamento viene visualizzata durante il processo di preriscaldamento.

Mostra I'avanzamento del processo di preriscaldamento, cosi come la temperatura attuale

e quella da raggiungere.

Toccare il tasto Annulla per annullare il

processo di preriscaldamento.
I'm heating up...

25%

Extruder 55°C /220°C

ﬁ
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Menu Strumenti
[l Menu Strumenti viene visualizzato toccando il tasto Strumenti nel Menu Principale.

e Toccare il tasto Filamento per caricare o

scaricare il filamento.

P
HOME
h—

e Toccare il tasto Livellamento per

livellare il piano di costruzione. Home

e Toccare il tasto Home per spostare

I'estrusore nella posizione iniziale.

e Toccare il tasto Manuale per visualizzare
la Schermata Regolazione Manuale.

e Toccare il tasto Impostazioni per visualizzare il Menu Impostazioni.
e Toccare il tasto Stato per visualizzare la Schermata Stato Stampante.
e Toccare il tasto Informazioni per visualizzare la Schermata Informazioni.

e Toccare il tasto Indietro per tornare al menu precedente.

Schermata Regolazione Manuale

La Schermata Regolazione Manuale mostra le posizioni X e Y dell’estrusore e la posizione Z

del piano di costruzione.

e Toccare il tasto X+ per spostare
I'estrusore verso destra.

e Toccare il tasto X- per spostare
I'estrusore verso sinistra.

e Toccare il tasto Y+ per spostare
I'estrustore verso la parte posteriore
della stampante.

e Toccare il tasto Y- per spostare
I'estrusore verso la parte anteriore della stampante.

e Toccare il tasto Z+ per alzare il piano di costruzione.

14



e Toccare il tasto Z- abbassare il piano di costruzione.

e Toccare il tasto Indietro per tornare al menu precedente.

Menu Impostazioni
Il Menu Impostazioni viene visualizzato toccando il tasto Impostazioni nel Menu Strumenti.

e Toccare la voce Lingua per selezionare 1np = &
la lingua per il Sistema Menu OSD.

Language English

e Toccare la voce WiFi per visualizzare la

Schermata WiFi. WiFi

e Toccare la voce Hotspot WLan per WLan hotspot
visualizzare la Schermata Hotspot
WLan.

Polar Cloud Connection

e Toccare la voce Calibrazione Estrusore per visualizzare la Schermata Calibrazione
Estrusore.

e Toccare il tasto Giu per visualizzare la seconda pagina del Menu Impostazioni.
e Toccare il tasto Indietro per tornare la menu precedente.

e Toccare il tasto Controllo Filamento per i3
attivare o disattivare il controllo del P
Extruder Calibration

filamento.

. Startup Sound
e Toccare il tasto Pausa Porta Aperta per g

attivare o disattivare la pausa

Filament Check

automatica della stampa quando la

porta viene aperta. Door Opened Pause

e Toccare la voce Reimpostazione di Fabbrica per reimpostare le impostazioni della
stampante ai loro valori predefiniti.

e Toccare la voce Aggiornamento per aggiornare il firmware della stampante.
e Toccare il tasto Sopra per visualizzare la prima pagina del Menu Impostazioni.

e Toccare il tasto Indietro per tornare al menu precedente.

15



Schermata Stato

La Schermata Stato viene visualizzata

toccando il tasto Stato nel Menu Strumenti.
Extruder: 367C

Door- Door Closed
e Toccare il tasto Indietro per tornare al Filament: Unloaded

Mostra in tempo reale lo stato della stampante.

menu precedente.

Schermata Informazioni

La Schermata Informazioni viene visualizzata e
toccando il tasto Informazioni nel Menu e e TR e
Strumenti. Mostra le informazioni di base Serial No : 123456
riquardanti la stampante Firmware Version: 1.0.0.123 20171215

9 P : Build Volume : 150x140x140

. . Extruder Number : 1
e Toccare il tasto Indietro per tornare al
Usage counter : 0 hours
menu precedente. IP-address : 10.33.23.109:8899

16



Schermata WiFi

La Schermata WiFi viene visualizzata toccando la voce WiFi nella Schermata Impostazioni.
La funzione Wi-Fi® le permette di collegare la Inventor Il a un Access Point Wi-Fi

(AP)/hotspot, per esempio quello a cui il suo computer € solitamente collegato. Pud anche
collegare la stampante in Monoprice FlashPrint in Modalita Stazione (STA) senza cambiare
le impostazioni di rete del suo computer.

e Toccare il tasto WiFi per attivare o .
disattivare la Wi-Fi.

e Quando la Wi-Fi e attivata, toccare il No connect
nome della rete Wi-Fi per selezionarla.

e Toccare il tasto Sopra per visualizzare la

pagina precedente della lista delle reti
Wi-Fi.

e Toccare il tasto Giu per visualizzare la nip
pagina successiva della lista delle reti

Wi-Fi. . .

. . = User's wifi

e Toccare il tasto Indietro per tornare al i
= Finder

menu precedente.

=. TP-LINK_F0C2

= JK222222

-2 home111
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Schermata Hotspot WLan

La Schermata Hotspot WLan viene visualizzata toccando la voce Hotspot WLan nel Menu
Impostazioni. La stampante Monoprice Inventor Il contiene una radio Wi-Fi® incorporata,
che pud essere configurata come Access Point Wi-Fi(AP)/hotspot. E quindi possibile
collegare la stampante in Monoprice FlashPrint cambiando la connessione Wi-Fi del proprio
computer con l'indirizzo Wi-Fi della stampante.

e Toccare il tasto On/Off per attivare o
disattivare I'hotspot WLAN.

e Toccare il tasto Impostazione hotspot
WLAN per visualizzare la Schermata MP Inventor |
Impostazione Hotspot WLAN. Setup WLAN hotspot

e Toccare il tasto Indietro per tornare al

menu precedente.

Schermata Impostazione Hotspot WLAN

La Schermata Impostazione Hotspot WLAN viene visualizzata toccando il tasto
Impostazione hotspot WLAN nella Schermata Hotspot WLan.

e Toccare il campo ssidname per (@)

impostare il nome dell’hotspot WLAN.
Setup WLAN hotspot

e Toccare il campo password per
. , ssidname: MP | tor Il
impostare la password dell’hotspot r Aventor

WLAN. password: 123456

e Toccare il tasto Salva per salvare le

Save

impostazioni.

e Toccare il tasto Indietro per tornare ai menu precedenti.

18



Schermata Regolazione Estrusore

La Schermata Regolazione Estrusore viene visualizzata toccando la voce Calibrazione
Estrusore nel Menu Impostazioni.

e Toccare il tasto - per aumentare la
distanza fra l'ugello dell’estrusore e il

WET

piano di costruzione in posizione

iniziale.

. o Z:0.0
e Toccare il tasto + per diminuire la

distanza fra l'ugello dell’estrusore e il
piano di costruzione in posizione

iniziale.
e Toccare il tasto OK per salvare i cambiamenti.

e Toccare il tasto Indietro per tornare ai menu precedenti.

DISIMBALLAGGIO

1. Posizionare la scatola su un piano da lavoro piatto e pulito.

2. Aprire la scatola. Afferrare la stampante dalle due impugnature ed estrarla dalla
scatola, quindi posizionarla sul piano da lavoro.

19



Rimuovere la scatola degli accessori e aprirla. Fare l'inventario del contenuto della
scatola per assicurarsi che tutte le parti siano presenti e in buono stato. Fare
riferimento alla sezione CONTENUTO DELLA CONFEZIONE.

Rimuovere l'imballaggio di polistirolo dalla stampante.
| e

Rimuovere il sacchetto di plastica dalla stampante.

20



6. Rimuovere I'imballaggio di polistirolo dalla parte superiore della stampante.

7. Rimuovere il nastro adesivo che tiene fermo il cavo piatto, quindi tagliare le quattro
fascette che tengono ferme le aste guida. Muovere manualmente l'estrusore sia nel
piano X che in quello Y per assicurarsi che si muova liberamente.

21



9. Rimuovere I'imballaggio di polistirolo dal lato sinistro, quindi sollevare manualmente
il piano di costruzione e rimuovere lI'imballaggio di polistirolo da sotto il piano di

costruzione.

10. Rimuovere la pellicola protettiva di plastica dal touch screen.

Congratulazioni, ha disimballato con successo la sua nuova stampante 3D!

CARICARE IL FILAMENTO

Eseguire i sequenti passaggi per caricare il filamento nella stampante 3D.

1. La Cartuccia del Filamento ¢ situata sul retro della stampante. Rimuovere la
cartuccia premendo verso il basso il tasto sulla parte superiore, quindi sollevando la
cartuccia.
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2. Collocare una bobina di filamento nello spazio apposito, quindi far passare il
filamento attraverso il gruppo di Rilevamento del Filamento nero, mostrato nel
riqguadro rosso nell'immagine sottostante. Si prega di notare che il filamento
dovrebbe passare dal basso della bobina verso I'alto. Inserire la cartuccia nella

3. Assicurarsi che I'Interruttore di Accensione sia in posizione OFF. Inserire il

stampante.

connettore dell’Adattatore di Alimentazione incluso nel jack dell'Ingresso di
Alimentazione.

23



4. Far passare il filamento all'interno del Tubo Guida del Filamento finché a farlo uscire
dal lato opposto.

5. Inserire il tubo guida del filamento nel foro d’Ingresso del Filamento posizionato
nella parte superiore della Cartuccia del Filamento.

6. Abbassare manualmente il Piano di Costruzione in modo da lasciare circa 5cm di
spazio fra 'Ugello dell’estrusore e il Piano di Costruzione.

7. Far scattare l'Interruttore di Accensione in posizione ON e aspettare che la

stampante si inizializzi.

8. Toccare il tasto Strumenti nel Menu Principale.

I X

Build Preheat Tools

24



9. Toccare il tasto Filamento nel Menu Strumenti, quindi toccare il tasto Carica.

~
HOME
)

Filament Home

Setting Status ’ ,

10. La stampante preriscaldera |'estrusore fino a 220°C. Una volta raggiunta la

temperatura desiderata, la stampante emettera un suono per avvisare di essere
pronta all’'uso.

Load begins,push filamentvertically into
extruder,and press [Done] when you see
filament come out of extruder

100%

Extruder 220°C [/ 220°C

1. Inserire il filamento nel foro d'Ingresso del Filamento nella parte superiore

dell’'estrusore. Il filamento sara attirato all'interno dell’Estrusore. Quando il filamento
inizia a estrudere dall'Ugello, toccare il tasto Fatto.

Congratulazioni, ha caricato con successo il filamento nella sua stampante!

25



LIVELLAMENTO DEL PIANO DI COSTRUZIONE

La Inventor Il & dotata di un sistema di livellamento intelligente a 3 punti, che offre un
feedback chiaro ed esaustivo. Sotto il piano di costruzione sono presenti tre manopole a
molla. Girare le manopole in senso antiorario (quando viste dall'alto) aumenta la distanza
fra il piano di costruzione e 'ugello dell’estrusore. Girarle in senso orario (quando viste
dall’alto) diminuisce la distanza fra il piano di costruzione e 'ugello dell’'estrusore.

Eseguire i seguenti passaggi per livellare il piano di costruzione.

1. Con la stampante ACCESA, toccare il tasto Strumenti nel Menu Principale.

I X

Build Preheat Tools

2. Toccare il tasto Livellamento, quindi aspettare mentre I'Estrusore e il Piano di

Costruzione terminano i loro movimenti iniziali.

~~
HOME
) —

Filament Leve Home W ERITE]

Please wait while the extruder and plarform
finish initial movements...
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3. Girare in senso antiorario (quando viste dall’alto) le tre manopole a molla situate
sotto il Piano di Costruzione fino a non poterle girare ulteriormente, quindi toccare
il tasto OK.

- " .-
AN, N

Screw three nuts under the platform
anticlockwise until you can't tighten them any
more,then tap [OK] button.

oK ﬁ

4. Confermare che non sia possibile girare ulteriormente le manopole, quindi toccare |l
tasto Sl.

Confirm

Are you sure you can't finger
tighten these three nuts any
more?

5. Aspettare mentre la stampante verifica la distanza fra il piano di costruzione e
I'ugello dell’estrusore al primo punto di livellamento.

Verifying the distance between nozzle and
plate...

9
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6. Girare in senso orario (quando vista dall’alto) la manopola situata sotto il punto di
livellamento fino a quando la stampante non emettera un suono.

Distance Too Big

Unscrew corresponding nut under
platform clockwise until hearing

a steady beep.
=
e, e sance

7. Toccare il tasto Verifica. La stampante verifichera nuovamente la distanza.

Wait

Please tap [Verify] button to
check whether the distance
is appropriate now.

Verify

8. Se la distanza e corretta, toccare il tasto OK per procedere al prossimo punto di
livellamento. Se non lo ¢, seqguire le istruzioni sullo schermo fino a ottenere la
distanza corretta e quindi alla visualizzazione del tasto OK.

Congrats

Tap [OK] button

to next point leveling.
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9. Continuare a sequire le istruzioni sullo schermo fino al corretto livellamento dei tre
punti e alla visualizzazione della Schermata di Completamento. Toccare il tasto Fine
per completare il processo di livellamento.

Completed!

Finish

Congratulazione, ha livellato con successo il Piano di Costruzione!

SCARICARE IL FILAMENTO

Eseguire i seguenti passaggi per rimuovere il filamento.

1. Quando la stampante e accesa, toccare il tasto Strumenti nel Menu Principale.

I X

Build Preheat Tools
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2. Toccare il tasto Filamento, quindi toccare il tasto Scaricare.

~ ~
HOME HOME
g g

Filament Home

Home

c 0O O i

Setting Status

Setting

La stampante preriscaldera l'estrusore fino a 220°C. Una volta raggiunta la

temperatura desiderata, la stampante emettera un suono per avvisare di essere
pronta all’'uso.

Unload begins,press down
spring presser and withdraw filament

100%

Extruder 220°C /220C

4. Abbassare il Pressatore a Molla verso I'estrusore, premere verso il basso il filamento

per 3 secondi, quindi tirare fuori il filamento. Non forzare il filamento perché
potrebbe danneggiare gli ingranaggi.
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SOFTWARE MONOPRICE FLASHPRINT

Installazione

La stampante 3D Inventor Il utilizza il softwer di slicing Monoprice FlashPrint per creare file
di stampa o per stampare direttamente dal computer attraverso un collegamento USB
cablato oppure wireless. Monoprice FlashPrint € disponibile per Microsoft® Windows® e
Linux®, sia in 32-bit che in 64-bit, cosi come per Apple® Mac® OS X®. | pacchetti

d’installazione Monoprice FlashPrint possono essere trovati sulla chiavetta USB inclusa.

Una volta individuato il pacchetto d'installazione del software, eseguire I'applicazione e
seqguire le istruzioni d’installazione visualizzate sullo schermo.

Impostazione Iniziale

Una volta installato Monoprice FlashPrint, fai doppio-click sulla scorciatoia dell’applicazione
per avviare il programma. Se € la prima volta che il programma viene aperto, verra
visualizzata una finestra che chiedera il Tipo di Macchina. Selezionare la voce MP Inventor
Il.

E anche possibile selezionare il Tipo di Macchina all'interno del programma cliccando
Stampa > Tipo di Macchina > MP Inventor I, come mostrato nella schermata sottostante.

@ FlashPrint - untitle.fpp
File Edit Print View Tools Help

& Connect Machine l

Machine Type > MP Creator Pro
MP Dreamer
MP Finder
MP Guider
MP Guider Il

\’ MP Inventor

‘ ®  MPInventor i

MP Hunter
1 7 ‘
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Panoramica dell'Interfaccia Principale

La schermata sottostante mostra i tre elementi principali del software, i Menu, le Icone e la
Piattaforma di Costruzione.

@ FlashPrint - untitie.fpp® - =] x

[Fle Edt Prit View Tools Help | que mMenus

«
:

4

{QH

build platform

=

L
[

‘N

o
=

MP Inventor II

Le icone hanno le funzioni elencate nella tabella sottostante.

Icona Funzione

Carica un modello oppure un file Gcode. Monoprice FlashPrint supporta
modelli in formato .STL, .OBJ e .FPP. E inoltre possibile caricare file .PNG,
JPG, .JPEG o .BMP e Monoprice FlashPrint generera un modello

Cari dallimmagine. Fare riferimento alla sezione Generare un Modello per
arica . .
ulteriori dettagli.

Entra in modalita Modifica Supporto.

Supporti
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Stampa direttamente da Monprice FlashPrint attraverso USB o

colegamento wireless, oppure esporta un file Gcode nella chiavetta USB.

Stampa
Visualizza la schermata iniziale di Monoprice FlashPrint da uno dei sei
angoli di visuale.
Vista

Muove il modello sul piano X/Y. Tenere premuto il tasto SHIFT e quindi

cliccare per muovere il modello sull'asse Z.

Gira e ruota il modello.

Scala

Scala la dimensione del modello.
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Taglia il modello in diverse parti.

Caricare un File

Monoprice FlashPrint supporta sei diversi modi per caricare un modello oppure un file

Gcode, come delineato qui sotto.

Cliccare l'icona Carica nell'interfaccia principale, quindi selezionare il file.

Trascinare e rilasciare il file nell'interfaccia principale.

Cliccare File > Carica File, quindi selezionare il file.

Cliccare File > Carica Esempi per caricare uno dei file esempio.

Cliccare File > File Recenti, quindi selezionare il file dalla lista dei file usati di ricente.

Trascinare e rilasciare il file sull'icona di Monoprice FlashPrint sul desktop per avviare

Monoprice FlashPrint e caricare il file.
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Generare un Modello

Monoprice FlashPrint € in grado di generare un modello 3D da un file immagine in formato
.PNG, .JPG, .JPEG oppure .BMP. Caricando il file immagine, verra visualizzata la seguente
finestra di dialogo, che permette di impostare diversi parametri per il modello.

Forma: Determina la forma base del modello.E | € Convert image to stl X
possibile selezionare le forme base Piano,
Tubo, Contenitore, Lampada o Sigillo. Shape: Flane M
. . . . . Moda: Tube
Modalita: Seleziona quali saranno i punti Canister
L L. Basze Thickness: Lamp
principali del modello fra quelli chiari e Seal
. . Maximum Thicknes=: [4 O0mm -
quelli scuri. , -
Width (X): | 103. 40mm o
Spessore Massimo: Imposta il valore Z del Tepth (¥): 44 00mm H
modello.
Cancel

Spessore di Base: Imposta lo spessore minimo
del raft. Il valore predefinito e di 0,5mm.

Larghezza: Imposta il valore X del modello.
Profondita: Imposta il valore Y del modello.

Spessore del Fondo: Imposta lo spessore del fondo dei modelli tubo, contenitore e
lampada.

Diametro della Cima: Imposta il diametro della cima dei modelli tubo, contenitore e
lampada.

Diametro del Fondo: Imposta il diametro del fondo dei modelli tubo, contenitore e
lampada.
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Le seguenti schermate illustrano le 5 forme base. The following screenshots illustrate the
five basic shapes.

Piano
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Lampada

Kotate

Sigillo

Seale

Cut

Cambiare Punti di Vista

E possibile cambiare I'angolo della telecamera in relazione al modello e all‘area di

costruzione usando diversi metod.i.

Trascina: Cliccare licona Vista, quindi trascinare la telecamera usando uno dei seguenti

e Cliccare il tasto sinistro del mouse e tenerlo premuto, quindi muovere il mouse.

e C(liccare e tenere premuta la rotella del mouse, quindi scorrere in alto o in basso.

e Tenere premuto il tasto SHIFT, cliccare il tasto destro e tenerlo premuto, quindi
muovere il mouse.
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Ruota: Cliccare licona Vista, quindi ruotare la telecamera usando uno dei seguenti
metodi.

e C(liccare il tasto destro del mouse e tenerlo premuto, quindi muovere il mouse.

e Tenere premuto il tasto SHIFT, cliccare il tasto sinistro del mouse e tenerlo

premuto, quindi muovere il mouse.

Scala: Scrollare la rotella del mouse in alto o in basse per ingrandire o diminuire la

visuale.

Imposta Vista: E possibile selezionare uno dei sei angoli di visuale predefiniti usando i

seguenti metodi.

e Cliccare il menu Vista, quindi selezionare una delle sei opzioni dalla lista a
cascata.

e Cliccare licona Vista, quindi cliccarci di nuovo per far apparire un sottomenu con

sei opzioni da selezionare.

Reimposta Vista: E possibile reimpostare 'angolo della telecamera a quello predefinito
usando uno dei seguenti metodi.

e Cliccare il menu Vista, quindi selezionare Vista Iniziale.

e Cliccare il tasto Vista, quindi cliccarci di nuovo per far apparire un sottomenu.
Selezionare l'opzione Reimposta.

Mostra Contorno Modello: E possibile impostare Monoprice FlashPrint in modo da
mostrare il contorno del modello evidenziato in giallo. Per farlo, cliccare sul menu
Vista, quindi selezionare I'opzione Mostra Contorno Modello.

Mostra Strapiombo: Quando I'angolo d’intersezione fra la superficie del modello e una
linea orizzontale rientra nel valore limite dello strapiombo, la superficie viene
definita "a strapiombo" ed € quindi mostrata in rosso quando l'opzione Mostra
Strapiombo ¢ attivata. Per attivare o disattivare Mostra Strapiombo, cliccare sul
menu Vista, quindi selezionare la voce Mostra Strapiombo. Il valore limite
predefinito e di 45 gradi.
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Manipolazione del Modello
E possibile manipolare il modello usando diversi metodi.

Muovi: Cliccare sul modello per selezionarlo. E quindi possibile muoverlo nell’area di

costruzione in diversi modi.

e Per muovere il modello orizzontalmente nel piano X/Y, cliccare il tasto sinistro

del mouse sul modello e tenerlo premuto, quindi muovere il mouse.

e Per muovere il modello verticalmente nel piano Z, tenere premuto il tasto SHIFT,
cliccare il tasto sinistro del mouse sul modello e tenerlo premuto, quindi
muovere il mouse.

e Cliccare il tasto Muovi, quindi inserire il valore della distanza. Cliccare Reimposta

per reimpostare i valori della distanza.

Nota: Dopo aver mosso il modello, cliccare Centra > Su Piattaforma per
assicurarsi che il modello sia nellarea di costruzione e in contatto con la

piattaforma di costruzione.

Ruota: Cliccare sul modello per selezionarlo. E quindi possibile ruotare il modello in tutti

e tre i piani in diversi modi.

e Cliccare licona Ruota e appariranno attorno al modello tre anelli mutualmente
perpendicolari. Cliccare e tenere premuto su uno degli anelli e muovere il mouse

per ruotare il modello in quel piano.

e Cliccare licona Ruota, quindi inserire manualmente i valori dell’angolo di
rotazione. Cliccare Reimposta per reimpostare i valori dell'angolo di rotazione.
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Scala: Cliccare sul modello per selezionarlo. E quindi possibile scalarlo in diversi modi.

e Cliccare licona Scala, quindi tenere premuto il tasto e muovere il mouse per
cambiare la scala. | valori corrispondenti saranno visualizzati vicino al modello.

e Cliccare licona Scala, quindi inserire i valori delle scale per gliassi X, Y e Z

e Cliccare licona Scala, quindi cliccare il tasto Massimo per impostare la
dimensione massima per |'area di costruzione.

e Cliccare licona Scala, quindi cliccare il tasto Reimposta per reimpostare la
dimensione del modello.

Si prega di notare che se il pulsante di opzione Scalatura Uniforme e attivato,
scalera il modello in proporzione quando viene cambiato qualsiasi valore di

dimensione.

Taglia: Cliccare il modello per selezionarlo, quindi fare doppio-click sull'icona Taglia per
impostare il piano di taglio in diversi modi.

e Cliccare il tasto sinistro e trascinare il cursore attraverso il modello per impostare
I'angolo di taglio.
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e Selezionare I'opzione Piano Y per tagliare verticalmente il modello.
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Supporti

Dal momento che la stampa 3D e un processo additivo, ogni strato di filamento necessita
una base su cui essere costruito. La stampante € in grado di aumentare gradualmente la
dimensione dello strato, a condizione che I'angolo d’inclinazione sia minore di 45 gradi.
Altrimenti sara necessario costruire degli elementi di supporto che servino come base per
aggiungere ulteriori strati. Per modificare i supporti, cliccare sul menu Modifica, quindi
selezionare la voce Supporti. Alternativamente, cliccare I'icona Supporti. Cliccare il tasto
Indietro una volta terminato di modificare i supporti.

@ FlashPrint - untitle.fpp* - (=] x

File Edit Print View Tools Help

Supports Auto Clear vk
Optisns—Supports] —Supperts

MP Inventor II
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Opzioni di Supporto: Cliccare il tasto Opzioni di Supporto per mostrare la finestra
Opzioni di Supporto. E possibile selezionare i supporti Ad Albero o Lineare. |
supporti Ad Albero sono costruiti ad angolo, mentre i supporti Lineari sono supporti
lineari e verticali adatti agli elementi inclinati. Una volta cliccato il tasto OK, il
software generera le appropriate strutture di supporto. Se il modello ha gia dei
supporti, il software giudichera se i supporti gia presenti devono essere eliminati o
no, in base al tipo di supporto esistente. Quindi mostrera la finestra di dialogo
corrispondente per lasciare che sia l'utente a prendere una decisione.

@

HOES

Clear

P B Back
Options— Suppor¥s] —Supports

| €@ Supports Options > |

\ MP Inventor II

Supporti Automatici: Cliccare il tasto Supporti Automatici per permettere al software di
giudicare dove siano necessari dei supporti e di generare i supporti corrispondenti,
lineari o ad albero. Se il modello ha gia dei supporti, il software li eliminera e
verranno generati dei nuovi supporti.

Aggiungi Supporti: Cliccare sul tasto Aggiungi per generare manualmente dei supporti.
Muovere il cursore sulla posizione dove c’e bisogno di un supporto, premere il tasto
sinistro per scegliere un punto di partenza, quindi tenendo premuto il tasto del
mouse, trascinare il mouse al punto di conclusione. Verra visualizzata un‘anteprima
del supporto e il supporto stesso verra evidenziato. Se la superficie di supporto non
ha bisogno di un supporto oppure I'angolo della colonna di supporto e troppo largo,
il supporto non sara generato.

Rimuovi Supporti: Cliccare sul tasto Rimuovi Supporti per rimuovere tutti i supporti
esistenti. Nel caso si cambiasse idea, cliccare sull’'opzione Annulla oppure premere
CTRL+Z.
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Elimina Supporti: Cliccare sul tasto Elimina Supporti per rimuovere dei supporti
individuali. Cliccare il cursore sul supporto che si desidera eliminare per evidenziare
quel supporto e tutti i supporti secondari, quindi cliccare il tasto sinistro del mouse

per eliminare il supporto evidenziato.

Stampare un Modello

Cliccare l'icona Stampa nell'interfaccia principale per sezionare il modello e stampare il file
Gcode risultante, sia direttamente da Monoprice FlashPrint sia esportandolo prima sulla
chiavetta USB.

I want to: Y| Preview Print When Slice Done

Machine Type: MP Inventor II

Material Type: IPLA >

Supports: |Enable Z
Raft: [Disable 2

Resolution: Low (Faster) ] wall

@ Standard Brim
High (Slower)
Hyper

More Options >>

Layer Height | Shels | Infil [ Speed | Temperature | Others |

Layer Height: 0.18mm
First Layer Height: 0.27mm

Restore Defaults|
[ oK ] ISave Conﬁguration:

Anteprima: Spuntare il riquadro Anteprima per visualizzare I'anteprima del modello

prima della sezionatura e della stampa.

Stampa a Sezionatura Completata: Spuntare il riquadro Stampa a Sezionatura
Completata per iniziare a stampare una volta completata la sezionatura.

Tipo di Materiale: Selezionare il tipo di filamento in uso.
Supporti: Attiva o disattiva la creazione di supporti.

Raft: Attiva o disattiva un Raft, che € composto da diversi strati di materiale sul piano di

costruzione per aiutare con l'adesione del modello.
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Muro: Spunta il riquadro Muro per facilitare la pulizia di filamento colato da

un’estrusore secondario durante la stampa a due colori.

Brim: Spunta il riquadro Brim per stampare un anello di filamento attorno al modello per
prevenire deformazioni e facilitare I'adesione del letto.

Risoluzione: Per la stampa in ABS e PLA, e possibile scegliere fra le risoluzioni Bassa,
Standard o Alta. Per la stampa in PLA, & inoltre possibile scegliere Iper. Piu € alta la
risoluzione e piu sara liscia la superficie del modello, ma incidera sulla velocita di

stampa.

Altre Opzioni: Cliccare sul tasto Altre Opzioni per rivelare schede con opzioni

aggiuntive.
Strato: Cliccare la scheda Strato per rivelare le opzioni di strato.

e Altezza Strato: Imposta lo spessore di ogni strato. Piu e sottile lo strato e piu
sara liscia la superficie del modello, ma incidera sulla velocita di stampa.

e Altezza del Primo Strato: Imposta lo spessore del primo strato del modello, che
incide sul modo in cui il modello aderisce al piano di costruzione. Lo spessore
massimo e di 0,4mm e in genere il valore predefinito e sufficiente.

Guscio: Cliccare la scheda Guscio per rivelare le opzioni di guscio.
e Gusci Perimetrali: Imposta il numero di gusci perimetrali. Il valore massimo & 10.

e Strati Solidi in Cima: Imposta il numero di strati solidi in cima al modello. Il valore

massimo e 30 e quello minimo e 1.

e Strati Solidi sul Fondo: Imposta il numero di strati solidi sul fondo del modello. Il

valore massimo e 30 e quello minimo e 1.

Riempimento: Cliccare la scheda Riempimento per rivelare le opzioni di riempimento. il
Riempimento ¢ la struttura che viene stampata all'interno del modello. Il
Riempimento influisce direttamente sulla resistenza del modello stampato.

e Densita del Riempimento: Imposta la densita del riempimento a incrementi del
5%. Una densita del 100% risulta in un modello solido, mentre una densita dello

0% risulta in un riempimento assente.
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e Modello del Riempimento: Permette di selezionare la forma della struttura di
riempimento.

e Combina Riempimento: E possibile selezionare gli strati per la combinazione
seguendo lo spessore dello strato. Lo spessore combinato non dovrebbe
superare gli 0,4mm. L'opzione Ogni N Strati € per tutto il riempimento, mentre
I'opzione Ogni N Strati Interni influisce solo sui riempimenti interni, che in
genere diminuisce il tempo di stampa.

Velocita: Cliccare la scheda Velocita per rivelare le opzioni di velocita.

e Velocita di Stampa: Determina la velocita a cui si muovera I'estrusore stampando
il filamento. Puo essere impostata a un valore cha va dai 10 ai 200 mm/sec a
incrementi di 10mm/sec. Minore ¢ la velocita e maggiore sara la qualita del
risultante modello stampato. Per la stampa in PLA, 80mm/sec ¢ la velocita
consigliata.

e Velocita di Viaggio: Determina la velocita a cui si muove l'estrusore spostandosi
da un punto all’altro quando non sta stampando filamenti. Puo essere impostata
a un valore che va dai 10 ai 200 mm/sec a incrementi di 10mm/sec. Minore ¢ la
velocita e maggiore sara la qualita del risultante modello stampato. Per la
stampa in PLA, 100mm/sec ¢ la velocita consigliata.

Temperatura: Cliccare la scheda Temperatura per rivelare le opzioni di temperatura.

e Temperatura dell’Estrusore: Imposta la temperatura dell’estrusore con valori che
vanno da 0 a 240°C, a incrementi di 5°C. Impostare la temperatura in base al
filamento stampato.

Altre: Cliccare la scheda Altre per rivelare opzioni aggiuntive.

e Pausa ad Altezze: Imposta l'altezza a cui la stampante sara messa
automaticamente in pausa. Questa opzione viene solitamente utilizzata per
permettere all’'utente di cambiare filamento in uno o piu punti. Cliccare il tasto
Modifica per impostare il punto (o punti) di pausa. La stampante puo essere
messa in pausa ovunque fra1e 59,9 mm.
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Menu File

Il Menu File contiene le seguenti opzioni.

Nuovo Progetto: Cliccare File > Nuovo Progetto oppure premere CTRL+N per creare un
nuovo progetto vuoto. Un progetto salva in un unico posto tutti i modelli nella
scena, incluse le posizioni, i supporti e le impostazioni. Se ci sono dei cambiamenti
non salvati effettuati su un progetto precedentemente caricato, verra chiesto di

salvare i cambiamenti.

7 ——
€ Information &

e Save changes to this file before closing?

l Yes No Cancel

Salva Progetto: Cliccare File > Salva Progetto oppure premere CTRL+S per salvare il

progetto attuale. | file progetti hanno un suffisso .FPP.

Carica File: Cliccare File > Carica File oppure premere CTRL+O per caricare un modello,

un Gcode oppure un file progetto.
Salva Come: Cliccare File > Salva Come per salvare il file progetto o modello.
Esempi: Cliccare File > Esempi per caricare uno dei quattro modelli predefiniti integrati.
File Recenti: Cliccare File > File Recenti per scegliere fra una lista dei file caricati di
recente.

Preferenze: Cliccare File > Preferenze per impostare diverse preferenze Generali e Di

Stampa.

e Lingua: Permette di scegliere la lingua usata in Monoprice FlashPrint.

e Dimensione Caratteri: Permette di impostare la dimensione dei caratteri usati in
Monoprice FlashPrint. E possibile scegliere fra Piccoli, Medi e Larghi.

e Cerca Aggiornamenti dopo lI'avvio: Determina se Monoprice FlashPrint cerchera

automaticamente l'esistenza di aggiornamenti del software o dei driver.
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e Layout automatico per modello appena importato: Determina se il software
regolera automaticamente la posizione di un modello immediatamente dopo
averlo caricato.

e Tipo della Finestra di Stampa: Permette di scegliere fra finestra di dialogo Base
(predefinita) oppure quella Esperto, con molte piu impostazioni individuali.

Esci: Cliccare File > Esci oppure premere ALT+F4 per uscire da Monoprice FlashPrint. Se
ci sono dei cambiamenti non salvati sul progetto o modello, verra chiesto all'utente
di salvare i cambiamenti.

Menlu Modifica

Il Menu Modifica contiene le seguenti opzioni.

Annulla: Cliccare Modifica > Annulla oppure premere CTRL+Z per annullare l'ultima
modifica effettuata. Nella maggior parte dei casi e possibile annullare molteplici
modifiche, una alla volta.

Rifai: Cliccare Modifica > Rifai oppure premere CTRL+Y per rifare 'ultimo cambiamento
che era stato annullato. Nella maggior parte dei casi € possibile rifare molteplici
annullamenti.

Svuota Pila di Annullamenti: Cliccare Modifica > Svuota Pila di Annullamenti per
svuotare la memoria del software dagli annullamenti recenti. Questa operazione ha
lo stesso effetto che avrebbe il salvare e ricaricare il file progetto o modello.

Seleziona Tutto: Cliccare Modifica > Seleziona Tutto oppure premere CTRL+A per

selezionare tutti i modelli nella scena.

Duplica: Cliccare Modifica > Duplica oppure premere CTRL+V per copiare il modello (o
modelli) selezionato.

Elimina: Cliccare Modifica > Elimina oppure premere il tasto Del per eliminare il modello
(o modelli) selezionato.
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Tutti i Layout Automatici: Cliccare Modifica > Tutti i Layout Automatici per organizzare
automaticamente il modello (0 modelli) sulla piattaforma di costruzione. Verra
chiesto all'utente di impostare la distanza fra i modelli, che pu® essere di un valore
compreso fra 1,0 e 50,0 mm.

Rifletti Modello: Cliccare Modifica > Rifletti Modello per riflettere il modello (o modelli)
selezionato nei piani X, Y o Z

Ripara Modelli: Clicca Modifica > RIpara Modelli per correggere qualsiasi errore nel
modello (o modelli) selezionato.

Supporti: Clicca Modifica > Supporti per entrare in modalita Modifica Supporto.

Menu Stampa
Il Menu di Stampa contiene le seguenti opzioni.

Collega Macchina: Cliccare Stampa > Collega Macchina per stabilire un collegamento
USB o Wi-Fi® con la stampante. Questa opzione non & disponibile se la stampante &

gia collegata.
,é Connect Machine ]
Comnect Mode: |USB 'l [ Cormect l
Select Machine: | "l | Rescan |
|

Disconnetti: Cliccare Stampa > Disconnetti per interrompere il collegamento con la
stampante. Questa opzione non e disponibile se non & presente alcun collegamento
con la stampante.

Stampa: Cliccare Stampa > Stampa oppure premere CTRL+P per aprire la finestra di
stampa.

Tipo di Macchina: Cliccare Stampa > Tipo di Macchina. Permette di selezionare il
modello specifico della stampante 3D da usare con Monoprice FlashPrint. Questa
stampante e la Monoprice Inventor Il.
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Menu Vista
[l Menu Vista contiene le seguenti opzioni.
Vista Iniziale: Imposta la telecamera nella posizione predefinita.

Vista dall’Alto: Imposta la telecamera in modo da guardare direttamente dall’alto in
basso sull’area di costruzione.

Vista dal Basso Bottom View: Imposta la telecamera in modo da guardare direttamente
dal basso in alto all'area di costruzione.

Vista da Sinistra: Imposta la telecamera in modo da guardare I'area di costruzione dal
lato sinistro.

Vista da Destra: Imposta la telecamera in modo da guardare I'area di costruzione dal
lato destro.

Vista Frontale: Imposta la telecamera in modo da guardare I'area di costruzione dal lato
frontale.

Vista Posteriore: Imposta la telecamera in modo da guardare I'area di costruzione dal
lato posteriore.

Mostra Contorno del Modello: Applica un contorno giallo attorno al modello.

Mostra Strapiombo: Evidenzia in rosso quelle porzioni del modello che necessitano di

supporti.

50



Menu Strumenti
Il Menu Strumenti contiene le seguenti opzioni.

Pannello di Controllo: Cliccare Strumenti > Pannello di Controllo per modificare le
impostazioni della stampante dall'interno di Monoprice FlashPrint. Si prega di notare
che nel caso l'utente non sia collegato con la stampante, gli verra chiesto di farlo
prima di poter visualizzare il Pannello di Controllo.

4 Control Panel E‘_Iﬂ
Homing
Jog Controls Extruder Controls
Tog Mode Motor Speed (REM) 5.00 <
S 8
X 10.0 Motor Contiols [ Forward | [ Reverse |[  stp |
st
Temperature Controls
O Extruder Target 0 B Extruder Current |15
Temperature Plot
/Y Speed - { 2000 nnfmin
Z Speed i} 80 | mn/min || 0 38
250
Linit Switch Stepper Motor Controls
200
X Maximun Switch: Not Triggered i
[ Enable ][ Dissble | g

T Maximum Switch: Not Triggered

I Maximum Switch: Triggered 100
Servo Controls

Filanent Detect S0
[ twnon || Twnoer |

Filament Status: Filament Loaded
When Extruder and Platform are both need to heat up, Extruder will NOT heat up
[ LED Color ] until Platform reach the given temperature.

e Modalita Jog: La Modalita Jog permette di selezionare la distanza percorsa
dall’estrusore e dal piano di costruzione con ogni click del mouse.

e Sei Tasti Blu a Freccia: | tasti permettono di muovere manualmente l'estrusore e
il piano di costruzione. Le impostazioni della Modalita Jog determinano di

quanto si muoveranno l'estrusore e il piano di costruzione.
e Stop: Cliccare il tasto Stop per annullare qualsiasi movimento attuale.

e Coordinate XYZ: Mostra la posizione attuale dell’estrusore e del piano di
costruzione. Non e possibile modificare i parametri mostrati.

e Imposta Posizione Attuale Come Posizione Zero: Cliccare il tasto Imposta
Posizione Attuale Come Posizione Zero per impostare la posizione zero dei tre

assi.

e Centra XYZ: Cliccare un dei tasti Centra per muovere l'estrusore o il piano di
costruzione alla posizione zero per quell’asse.
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e Imposta Velocita X/Y: Imposta la velocita a cui si muove I'estrusore.
e Imposta Velocita Z: Imposta la velocita a cui si muove il piano di costruzione.

e Interruttore di Limite: Mostra lo stato degli interruttori di limite di ciascun asse.
Se I'estrusore o il piano di costruzione non sono stati posizionati alle loro
posizioni massime, lo stato mostrera Non Attivato in verde. Se I'estrusore o il
piano di costruzione sono stati posizionati alle loro posizioni massime, lo stato
mostrera Attivato in rosso.

e Controlli del Motore Passo-Passo: Cliccare il tasto Attiva per bloccare il motore
passo-passo cosi da impedirgli di muoversi. Cliccare Disattiva per sbloccare |l
motore passo-passo in modo da poter muovere manualmente |'estrusore e |l

piano di costruzione.
e Colore LED: Permette di scegliere il colore LED della stampante Inventor II.

e Velocita Motore (RPM): Controlla la velocita della ruota di alimentazione del

filamento.
e Durata Estrusore: Controlla la durata della rotazione del motore.
e Avanti: Alimenta filamento all’estrusore.
e Indietro: Scarica filamento dall’estrusore.
e Stop: Ferma il movimento del motore quando si alimenta o scarica il filamento.

e Controllo Temperatura: Permette di impostare la temperatura dell’estrusore da
raggiungere. Cliccare il tasto Applica per iniziare a scaldare l'estrusore.

Aggiorna Firmware: Permette di aggiornale il firmware della stampante.
Preferenze A Bordo: Permette di controllare il nome della stampante.

Informazione sulla Macchina: Mostra informazioni sulla stampante, inclusa la versione

del firmware.
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Menu Aiuto
[l Menu Aiuto contiene le seguenti opzioni.

Primo Installatore: Avvia nuovamente l'installatore che viene avviato automaticamente
la prima volta che si apre Monoprice FlashPrint.

Contenuti di Aiuto: Permette di leggere i file di aiuto.
Feedback: Permette all’'utente di lasciare un feedback.

Cerca Aggiornamenti: Controlla se sono presenti degli aggiornamenti per Monoprice
FlashPrint.

Riguardo MP FlashPrint: Mostra le informazioni della versione di Monoprice FlashPrint.

COLLEGARE LA STAMPANTE

Ci sono tre modi per collegare il software Monoprice FlashPrint alla stampante Inventor Il -
un collegamento USB cablato, un collegamento wireless con la stampante funzionante
come punto di accesso Wi-Fi/Hotspot WLAN, oppure un collegamento wireless usando un
punto di accesso Wi-Fi® pre-esistente.

Collegamento USB

Esequire i seguenti passaggi per collegare il proprio PC alla stampante Inventor Il usando
un collegamento USB cablato.

1. Inserire una delle estremita del cavo USB incluso nella porta USB della stampante,
quindi inserire 'altra estremita nella porta USB del proprio computer.

2. Accendere la stampante e il proprio computer, quindi aprire il software Monoprice
FlashPrint.
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3. Cliccare Stampa > Collega Macchina.

ZG Connect Machine S
Cotmect Mode: |USB v| [ Connect ]
Select Machine: | "'| | FEescan |

|

4. Impostare la Modalita di Collegamento su USB e impostare l'opzione Seleziona
Macchina sulla stampante Inventor Il. Se la stampante non dovesse comparire nella
lista Seleziona Macchina, cliccare sul tasto Nuova Scansione. Nel caso non
comparisse ancora, e consigliato reinstallare i software driver.

Collegamento Hotspot WLAN

Eseguire i seguenti passaggi per collegare il proprio PC alla stampante Inventor Il usando
I'hnotspot WLAN incorporato nella stampante.

1. Accendere la stampante e il proprio computer.

2. Sulla stampante, selezionare Strumenti > Impostazioni > Hotspot WLan > Hotspot
WLan ON.

3. Aprire le impostazioni di rete wireless del proprio computer e effetture una
scansione per i segnali Wi-Fi® disponibili. Selezionare la voce Inventor Il, quindi
premere Collega.

4. Avviare il software Monoprice FlashPrint, quindi cliccare Stampa > Collega
Macchina.
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5. Impostare la Modalita di Collegamento su Wi-Fi, quindi inserire I'Indirizzo IP della
stampante e cliccare Collega.

e

Machine Type : Monoprice Inventor |
Serial No : 123456

Firmware Version: 1.0.0.224 08 20170426-6
Build Volume : 150x140x140

Extruder Number : 1

Usage counter : 60 hours
|P—address : 192.168.0.222:8899

IIIP Connect Machine X

Connect Mode: ¥i-Fi -

IP Address (port): 192 168 . 0 . 222 8399

R — T

Collegamento Wi-Fi

Esequire i seguenti passaggi per collegare il proprio PC alla stampante Inventor Il usando
un punto di accesso Wi-Fi® pre-esistente.

1. Accendere la stampante e il proprio computer.
2. Sulla stampante, selezionare Strumenti > Impostazioni > Wi-Fi > Wi-Fi ON.
3. Individuare e selezionare il segnare Wi-Fi a cui e collegato il proprio computer.

4. Avviare il software Monoprice FlashPrint, quindi cliccare Stampa > Collega
Macchina.
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5. Impostare la Modalita di Collegamento su Wi-Fi, quindi inserire I'Indirizzo IP del
proprio punto di accesso Wi-Fi e cliccare Collega.

lnip = & 1

Machine Type : Monoprice Inventor |
Serial No : 123456

Firmware Version: 1.0.0.224 08 20170426-6
Build Volume : 150x140x140

Extruder Number : 1

Usage counter : 60 hours
|P—address : 192.168.0.222:8899

IIIP Connect Machine X

Connect Mode: ¥i-Fi -

IF Address (port): 192 168 . 0 . 222 : 8399

| el T

STAMPARE

Eseguire i seguenti passaggi per stampare un modello con la stampante Inventor Il a partire
da un file Gcode salvato sulla chiavetta USB.

Generare un Gcode
1. Inserire la chiavetta USB in una porta USB del proprio computer.

2. Fare doppio-click sulla scorciatoia di Monoprice FlashPrint per avviare il software.

FI3shPrint

3. Cliccare Stampa > Tipo di Macchina e selezionare la voce MP Inventor II.

i File Edit Print View Tools Help

& Connect Machine _

2 Disconnect m
Print Ctrl+P

Load
Machine Type 4

{ 0 ~—
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4. Cliccare l'icona Carica per caricare un file modello in formato .STL. Il modello
apparira all'interno dell’area di costruzione.

5. Fare doppio-click sull'icona Sposta, quindi cliccare sui tasti Sulla Piattaforma e
Centra per assicurarsi che il modello sia in contatto con il centro della piattaforma di

costruzione.

File Edit Print View Tools Help

— = = ~m“‘“""““‘w1 l:uild platforn
" Back

e I}

6. Cliccare I'icona Stampa, quindi cambiare le impostazioni in base al proprio tipo di
filamento e modello.

Anteprima: Spuntare il riquadro Anteprima se si desidera visualizzare
un‘anteprima del modello prima che la sezionatura sia completata.

e Stampa a Sezionatura Completata: Dal momento che si sta stampando dalla
chiavetta USB, deselezionare questo riquadro per salvare il file Gcode sulla
chiavetta USB.

e Tipo di Macchina: Selezionare la MP Inventor Il.

e Tipo di Materiale: Selezionare il tipo di filamento che si sta utilizzando.

e Supporti: Se il proprio modello ha elementi inclinati, attivare I'opzione Supporti.
e Raft: E consigliato attivare I'opzione Raft.

e Risoluzione: E consigliato selezionare 'opzione Standard.

e Altre Opzioni: E consigliato lasciarle ai loro valori predefiniti.
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7.

10.

M.

Cliccare OK per salvare il file Gcode. Salvarlo sulla chiavetta USB. E possibile
rinominare il file a proprio piacere e salvaro sia come file .g sia come file .gx. E
possibile visualizzare 'antemprima dei file con I'estensione .gx ma non di quelli con
estensione .g.

Test_01.9 pavilion.gx

box.g L warrior.gx
small_modify.g N basket.gx

apple.g ; key chain.gx

Rimuovere la chiavetta USB, quindi inserirla nella porta USB della stampante.

Accendere la stampante Inventor II.

Assicurarsi che il piano di costruzione sia livellato e che il filamento sia stato
caricato.

Toccare il tasto Costruzione sullo schermo della stampante.

T 1§ X

Build Preheat Tools
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12. Toccare I'opzione Chiavetta USB, quindi trovare e caricare il proprio file modello.

Internal Memory pavilion.gx

3.00GB, 4.00GB
o

warrior.gx

USB Stick
1.25GB, 7.80GB
basket.gx

key chain.gx

13. Toccare l'icona Costruzione per iniziare a stampare. La stampante iniziera a
riscaldare I'estrusore, quindi iniziera a stampare una volta raggiunta la temperatura
desiderata. Toccare il tasto Annulla in qualsiasi momento per annullare la stampa.

1P

20mm_box.gx
' 20mm_box.gx [

. Extruder 220°C/220°C
Total: Ohrs 18mins

Time left. Ohrs 13mins

T 8 m "

Build Copy Delete Abort Pause

SUPPORTO TECNICO

Monoprice ¢ lieta di fornire supporto tecnico gratis, online e in tempo reale per assisterla
con qualsiasi domanda lei possa avere riguardo installazione, impostazione, risoluzione
problemi oppure consigli per gli acquisti. Se mai dovesse avere bisogno di aiuto con un suo
nuovo prodotto, non esiti a contattarci online e parlare con uno dei nostri amichevoli ed
esperti Assistenti al Supporto Tecnico. Il supporto tecnico € disponibile attraverso il tasto
di chat online presente sul nostro sito web www.monoprice.com durante il normale orario
lavorativo, 7 giorni a settimana. Pud anche ricevere assistenza via email mandando un

messaggio all'indirizzo tech@monoprice.com
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SPECIFICHE

Modello

30525

Nome della Stampante

MP Inventor Il

Numero di Estrusori

1

Tecnologia di Stampa

Fabbricazione a Fusione di Filamento (FFF)

Tipo di Schermo

Touch screen a colori IPS da 3.5"

Area di Costruzione

150 x 140 x 140 mm

Risoluzione Strato

01-04 mm

Precisione di Costruzione

£0.1mm

Precisione di Posizionamento

Asse XY: 0.011mm, Asse Z: 0.0025mm

Diametro del Filamento

1.75mm +0.07mm

Diametro dell’Estrusore

0.4mm

Velocita di Costruzione

10~200 mm/sec

Software

MP FlashPrint

Formati d’'Ingresso Supportati

3MF, .STL, .OBJ, .FPP, .BMP, .PNG, .JPG, .JPEG

Formati d'Uscita Supportati

.G, .GX

Sistemi Operativi Supportati

Windows® XP e superiore (32-bit and 64-bit),
Mac® OS X®, Linux®

Potenza d'Ingresso

100 ~ 240 VAC, 50/60 Hz

Consumo

65 watt

Connettivita

Cavo USB, chiavetta USB, Wi-Fi®

Dimensioni

420 x 420 x 420 mm

Peso

1.7 kg
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CONFORMITA NORMATIVA

Avvertenza per la FCC

FS

Questo dispositivo & conforme alla Parte 15 delle Regole FCC. L'utilizzo € soggetto alle

seguenti due condizioni:
(1) Questo dispositivo non deve causare interferenze dannose,

(2) Questo dispositivo deve accettare qualsiasi interferenza ricevuta, incluse quelle

interferenze che potrebbe causare un funzionamento indesiderato.

Attenzione: Effettuare cambiamenti o modifiche non espressamente approvate dalla parte
responsabile per la conformita potrebbe invalidare il diritto dell’'utente di utilizzare il

dispositivo.

Questo dispositivo e stato testato e trovato conforme con i limiti per un dispositivo
digitale di Classe B, in conformita alla Parte 15 delle Regole FCC. Questi limiti sono
progettati per fornire una protezione ragionevole contro interferenze dannose nel
contesto di un’installazione residenziale. Questo dispositivo genera, usa e pud emanare
frequenze radio e, se non installato e usato in conformita con le istruzioni, potrebbe
causare delle interferenze dannose alle comunicazioni radio. Tuttavia, non e garantito che
non si verifichino interferenze in una particolare installazione. Se questo dispositivo
dovesse causare interferenze dannose alla ricezione radiofonica o televisiva, che puo
essere determinato accendendo e spegnendo il dispositivo, I'utente & incoraggiato a

correggere l'interferenza in uno dei seguenti modi:
e Riorientare o riposizionare lI'antenna ricevente.
e Aumentare la distanza fra I'apparecchiatura e il ricevitore.

e Collegare I'apparecchiatura in una presa situata in un circuito differente da quello a

cui @ connesso il ricevitore.

e Chiedere aiuto al rivenditore oppure a un tecnico radio/TV esperto.
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Avvertenza per Industry Canada

Questo apparato digitale di Classe B € conforme con la norma Canadese ICES-003.

Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canad.

C€

Dichiarazione di conformita UE

Monoprice, Inc. dichiara che il prodotto descritto in questo manuale/guida per l'utente &
conforme alle direttive applicabili di seguito. Il testo completo della Dichiarazione di
conformita UE & disponibile al seguente indirizzo Internet:
https://www.monoprice.com/product?c_id=107&cp_id=10724&cs_id=1072403&p_id=30525
&seq=1&format=2 In alternativa, la Dichiarazione di conformita UE e riportata in questo
manuale per l'utente.

e Direttiva CEM 2004/108/CE

e Direttiva sulla bassa tensione 2014/35/UE

e Direttiva RoHS2 2011/65/UE

e Direttiva RAEE 2012/19/CE

e Direttiva sugli imballaggi e i rifiuti di imballaggio 94/62/CE

e Direttiva REACH 1907/2006/CE
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Direttiva RAEE

Informazioni per I'utente relative ai prodotti di consumo coperti dalla Direttiva UE
2012/19/UE sui rifiuti di apparecchiature elettriche ed elettroniche (RAEE).

Questo documento contiene informazioni importanti per gli utenti in merito al corretto
smaltimento e riciclaggio dei prodotti Monoprice. | consumatori sono tenuti a rispettare
questo avviso per tutti i prodotti elettronici su cui € riportato il seguente simbolo:

i

Per i consumatori nell'Unione europea: questa direttiva UE richiede che il prodotto recante
questo simbolo e/o il suo imballaggio non siano smaltiti insieme ai rifiuti urbani
indifferenziati. Il simbolo indica che questo prodotto deve essere smaltito separatamente
dai normali flussi dei rifiuti domestici. E responsabilita dell'utente smaltire questo e altri
prodotti elettrici ed elettronici tramite strutture di raccolta designate e stabilite dal
governo o dalle autorita locali. Il corretto smaltimento e riciclaggio contribuiranno a
prevenire potenziali conseguenze negative per I'ambiente e la salute umana. Per
informazioni piu dettagliate sullo smaltimento di un determinato prodotto indesiderato,
l'utente pu0 contattare le autorita locali, il servizio di smaltimento rifiuti o il negozio in cui
e stato acquistato il prodotto.
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Avviso di sicurezza

ATTENZIONE: non utilizzare questo prodotto vicino all'acqua, per esempio in uno
scantinato umido o vicino a una piscina o in un'area in cui potrebbe verificarsi un contatto
accidentale con acqua o liquidi

ATTENZIONE: evita di usare questo prodotto durante un temporale, poiché potrebbe
esserci un rischio remoto di scosse elettriche derivanti dal sovraccarico causato dai fulmini

ATTENZIONE: I'alimentatore esterno o il cavo di alimentazione CA e il dispositivo di
disinserzione dell'apparecchiatura. La presa di corrente deve essere posizionata vicino
all'apparecchiatura e deve essere di facile accesso

ATTENZIONE: utilizzare il prodotto in un’area ben ventilata
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